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About Drop Words

About Drop Words

“Drop Words” is a technique used extensively in Hebrew typesetting. He-
brew drop words differ from standard drop caps in a number of ways. Firstly,
they are applied to the whole word, while standard drop caps are generally
applied to just the first letter. Secondly, they are used on (almost) every
paragraph. This is something which makes manual setting of the drops un-
practical. Lastly, the drops are “virtual drops”. With normal drop caps, the
characters which are dropped are enlarged to take up the number of lines for
which they are set. Drop words, although often slightly larger than the rest of
the text, only take up the first line. The line below is indented to start directly
below the second word.

Creating all this formatting manually is a very tedious process. This plug-in
was created to automate the process of creating these virtual drop words.
There is a script originally written by Dave Saunders, and ultimately im-
proved upon by us which helps in the automation. The script can be down-
loaded from here. However you may find it cumbersome and inefhicient to
use in production work, especially when there is a need to update them at
a later point in time. Additionally the script can take a relatively long time
when run on long documents. Drop Words was completely re-written to en-
able much more extensive automation and ease of use, as well as being very
quick to run. The typographical quality of the dynamic drop words created
by the Drop Words plug-in is also superior to that of the script.




http://www.in-tools.com/indesign/scripts/freeware/OneWordDrop.zip
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Installation
Drop Words was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 14.

All the necessary components of Drop Words are installed in a single step by

our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

MmOO ‘e Install Publisher Suite
- k l. Custom Install on “Macintosh HD"
INsylools.com
Package Name Action Size

© Introduction U InDesign CS3 Install 5.3 MB

# InDesign C54 Install 5.8 MB
ffid Me ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )
P

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmw Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

:Ili— Setup - Reflective Object:

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Mext = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe\Adobe InDesign C54' for InDesign C54.

To continue, dick ‘Next', If you would like to select a different folder, dlick 'Browse',

C:\Program Files (x86)\Adobe\Adobe InDesign CS4| Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs
lin!toolscom

m Plugins

Product Status Latest Version

World Tools Activated 1.0.5 Update:

—
Fead Hanual

AutoFlow Pro Activated 1.0.8

Column Flow Activated 1.0.7

) Style Utilitles Activated 1.0.8
1 Proper V] Activated 1.0.6
Gt Help Reflective Objects Activated 1.05

Power Headers Activated 2.0.5

Side Heads Activated 1.0.7
Story Control Activated 1.0.7

Drop Words Demo: 23 days left FActiuate 1.0.5

Drop Words creates “drop woerds” commaonly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InNDesign. | “camecin o 7ot wessie. resse wote.

Cancel
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To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: @ sales@in-tools.com Password: ok kK

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

By

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Drop Words #1

There are two versions of the drop words function available using the Drop
Words plug-in. They are named “Drop Words”, and “Drop Words 2”. The
setup and usage of the two versions are very different and will be explained

separately.

Setup

Drop Words uses paragraph styles as the basis for creating the drop words.
You must set up your document with styles for the drop words to properly
function. “Drop Words #1” creates drop words using the standard drop caps
function of InDesign. To properly create the drop words, the drop caps set-
tings in your paragraph styles must be properly set up. The paragraph style
should have the drop caps set to drop two lines. The number of characters
set to drop is unimportant. It will be adjusted to the correct number of char-

acters by Drop Words.

To ensure that the first word(s) retain the proper size and vertical position,
the paragraph style should be set up using a character style for the drop cap.
The drop cap character style should be a reduced size. The exact size would
depend upon the point size and leading of the paragraph. Additionally, the

baseline shift will need to be moved up.

Note: The size of the drop cap characters can be reduced by either changing the
point size, or by using glyph scaling. The glyph scaling method will work in cs and
cs2. In cs3, there is a bug, which does not allow applying the glyph scaling in a
drop cap, so the point size must be changed instead.
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Running Drop Words #1

Before applying the drop words in a document, you must select which para-
graph styles should have the drop words applied. The styles to receive the
drop words can be added, modified, or removed. Here’s the dialogs for se-
lecting the styles:

Define Word Drop Word Caps

Paragraph Style to Define: [ [No Paragraph Style] 3] x> Word Caps from paragraph style: | [No Paragraph Style] 3] ]
( Cancel ) (" Cancel )
What to Do: &) Create New Word Drop Number of Words: 1

O Modify Style

) Remove

In the first dialog, for each paragraph style to receive the drop words, click
“Create New Word Drop”. If you would like to modify an existing definition,
select the appropriate style, and click “Modify”. Creating a new drop word,
or modifying an existing one, will bring up the second dialog. The options
for setting the drop word definitions are very straight-forward. Select the

paragraph style, and the number of words to drop.

Once all the styles are set up, apply the drops to the specified number of
words, by simply selecting: InTools > Drop Words > Run Drop Words.
This will update all the paragraphs in the document.

Please note: All settings applied by Drop Words #1 are static. When the drop
words are applied, the paragraph styles will appear as overridden. (They will
have the little “plus” sign near the style name.) Clearing overrides will undo the
effects of Drop Words. Additionally, changes to the drop word text will not cause
a dynamic update. Either one of these situations necessitate running Drop Words

again.
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Drop Words #2

Drop Words 2 is a complete rewrite on the concept of drop words. It works
using an entirely different method, and requires a totally different setup. The
reason we included both functions, is there are advantages to both ways.
(Although the advantages to the second method probably outweigh the dis-

advantages — you decide!)

The advantages to Drop Words #1 are as follows: =~ ® Drop words #1 can be
run on text before it is properly placed. It doesn’t matter if the text is over-
set, etc. Drop Words #2 requires the text to be set. At the very minimum it
must not be overset, but ideally it should be set in its final formatting before
creating the drop words. ~ ® Drop Words #1 can be vertically justified us-
ing InDesign’s built in vertical justification, while Drop Words #2 cannot.
To vertically justify text formatted using Drop Words #2, you can use our
Proper V] plug-in instead. = ® Drop Words #1 can be created on the whole
document at once (assuming the styles are previously chosen), while Drop
Words #2 must be run for each style separately. ® Drop Words #2 will
only work using CS2 and higher.

The advantages of Drop Words #2 are as follows: ~ ® The spacing between
the drop word and the rest of the text is adjusted to match the spacing in the
rest of the line. Spaces in drop caps (used in Drop Words #1) are fixed spaces,
and not adjusted by the justification of the paragraph. The flexible spacing
in Drop Words #2 creates a much more unified look. ~® The drop words
in Drop Words #2 are dynamic. This means that editing the drop words will
automatically adjust the size of the drop words. Deleting the drop word text
will remove the drop words entirely. ® Drop Words #2 does not override

the paragraph style settings, so clearing overrides will not effect the drop
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words. @ Any drop caps bugs in InDesign (and there are quite a few...)
will affect Drop Words #1 but not Drop Words #2. @ The drop words in

Drop Words #2 require no resizing or baseline shifting.

Setup

Since drop words are only used in right to left text, Drop Words 2 was de-
signed to function on right-to-left paragraphs only. If you try to run it on
left-to-right paragraphs, nothing will happen.

To run Drop Words 2, you must set up two different paragraph styles. The
first style will apply formatting to the parent paragraph, while the second
one will apply the formatting to the drop words alone. If there is more than
one word in the drop word, the second style can be set up to apply all the for-
matting to the different words using nested styles. The second style should
be set up using the true point size and baseline position (unlike Drop Words
#1).

Using Drop Words 2

To create “Drop Words 2” drop words, simply select: InTools > Drop Words
- Run Drop Words 2. This must be repeated for each paragraph style.

Drop Words

r oK
Drop Words from Paragraph Style: = [No Paragraph Style] | :] ;)
Paragraph Style to Apply to Drop Words: = [No Paragraph Style] | :! ﬂ)

Number of Words: 1 ':] " Resize all Drop Frames

Above is the dialog used for creating “Drop Words 2” drop words. The op-

tions are self-explanatory. The top drop down list is for selecting the parent
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paragraph which should receive the drop words. The second drop down list
is for selecting the paragraph style to apply to the words which are to be
dropped. In the “Number of Words” input field, select the number of words
to drop. “The Resize all Drop Frames” option will force an update on all
existing drop words in the selected style. It is not usually necessary, but the

option offers a way to force the re-flow.

Drop Word Re-formatting

Once the drop words are created, the size of the drop will be adjusted auto-
matically any time the drop words are edited. Depending on the number of
drop words, and the processor speed of the computer, the updates can take
some time. If the text is reformatted in a way that affects a number of drop
words, you will be prompted to okay the updates. If you cancel the updates,
make sure to select “Force Update” to fix the spacing (and possibly overset
drop words). You can force the update by selecting InTools > Drop Words
- Force Update Drop Words 2.

Please note: Do to an unresolved issue with the Drop Words plug-in, it is pos-
sible to sometimes be prompted more than once in rapid succession after changing
formatting. If there was only one change of formatting, it is safe to dismiss all
prompts following the first one.

Removing Drop Words

The drop words are created as inline frames in the story stream. The text of
the drop words themselves are actually a separate story. If the text is export-
ed to be edited in an external program, the drop words must be removed
first. To remove the drop words simply select InTools > Drop Words >
Undo Drop Words 2. If no text is selected, you will be presented with the
following dialog:
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Remowe Drop Words |

oK
Remowve Drop Frame in Style: [ Al ) :'] ;}
Cancel

You have the option of removing the drop words from either the whole doc-
ument, or only from a specific paragraph style. IF there is text selected, you

will have an additional option as shown in the dialog below:

Remove Drop Words
Remove From: {®) Selection @
() Paragraph Style
Remowve Drop Frame in Style: [ Al | :i

If “Selection” is selected, only the drop words in the selected text will be

removed.

Applying Drop Words to Selected Text

If you need to apply the Drop Words to specific text, that can be done as
well. Select “InTools > Drop Words > Drop Selected Paragraphs...” and
select the number of words to drop, and style to use for the Drop Words:

Drop Words |

OK
Paragraph Style to Apply to Drop Words: [[No Paragraph Style] |+% '] ;)

Number of Words: 1 :] [ Cancel
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Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.

To achieve true integration, plug-ins must be programmed using c++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID Tool-
Assistant is a plug-in which allows very fine grained event processing using
ExtendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of
hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-

sistant plug-in installed can create and use these attached scripts. There
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are also additional scripting properties and methods which are usable by

scripters. For more information see Rorohiko’s web site.






Drop Words

Acknowledgements

We wish to thank the many people who have helped make In-Tools plug-ins
possible.

To those who give graciously of their time and expertise on the InDesign
scripting forum: thank you for introducing us to automating within InDe-

sign. Most specifically, Dave Saunders, Olav Kvern, and Peter Kahrel.

To Kris Coppieters, thank you for your incredible support throughout the
entire development process. Your help with product improvements and
with coding tips and techniques has been incredible. Your support has been
above and beyond what we could have reasonably expected. It has really

been a pleasure working together. Thank you.

To all our beta testers, thank you for the valuable input which helped shaped
our plug-ins. To Brad Walrod: a special thank you for your unrelenting com-
ments and suggestions. To Peter Gold and Raphael Freeman: thank you for

your many useful suggestions.





License Agreement

License Agreement
Please read the following document carefully!

Thisis alegal agreement (the Agreement) between you and Print Israel LLC (In-Tools),
the developer of the In-Tools software. This Agreement pertains to your use of the In-
Tools software and documentation which are provided to you by In-Tools (collectively,
the Software). By copying, installing, or otherwise using the Software, you accept all
the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions

contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the




http://www.in-tools.com/privacy.html
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, ORAS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE ORDATA. YOU ASSUME TOTAL RESPONSIBILITY AND
RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND OR NATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Departmentss list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.





		About Drop Words

		Installation

		Macintosh Install

		Windows Install



		Purchasing Licenses and Activation

		Drop Words #1

		Setup

		Running Drop Words #1



		Drop Words #2

		Setup

		Using Drop Words 2

		Drop Word Re-formatting

		Removing Drop Words

		Applying Drop Words to Selected Text



		Addendum

		What is “APID ToolAssistant”?



		Acknowledgements

		License Agreement




Mind Hyph

Version 1.0

Reference Manual

SSSSSSSS





MindHyph 1.0.1 for Adobe InDesign/InCopy

Installing Hyphenation Languages

MindHyph currently supports the Hyphen hyphenation services. As of the time of printing this is currently
about 50 languages. For an up-to-date list of languages available please go to the MindHyph url at http://
www.mindsteam.com/products/MindHyph/languages.html. MindHyph 1.0.1 ships with Hyphen 2.6.

Hyphen is a related project to the Hunspell dictionary project, which is supported by MindSteam’s “MindSpell”
product. As such, the hyphenation files need to be installed into the “MindSpell->Hunspell” language director-

ies. The MindHyph plug-in file is installed into the “MindSpell” directory as well.

MindHyph initially installs one hyphenation dictionary, English: USA. To install additional languages you will
need to download a hyphenation dictionary.

You will find Hyphen compatible hyphenation dictionaries at the following urls:

http://wiki.services.openoffice.org/wiki/Dictionaries
http://ftp.services.openoffice.org/pub/OpenOffice.org/contrib/dictionaries/

On Macintosh the installed hyphenation languages are located at:

/Applications/InDesign CS<x>/Plug-ins/Dictionaries/MindSpell/Hunspell/<xx YY>

On Windows the installed hyphenation languages are located at:

/Program Files/InDesign CS<x>/Plug-ins/Dictionaries/MindSpell/Hunspell/<xx YY>

In all the above examples the folder name <xx_yy> should be replaced with the correct ISO language and cou-

ntry codes for your language. For example, en_Us is English (United States). Please note the use of case in the
folder name.

”

The hyphenation file will have the string “hyph_” prepended to the name of the language and country code. So
“hyph_en Us.dic” is the required file for the English: USA hyphenation.

|Z| Mind Hyph Page 2





Be aware that not all hyphen data files are named the same. In some cases they may be named “hy ”. Itis
essential the file be renamed to match the format expected by MindHyph, “hyph xx yy.dic”.

Note: Hyphen .dic files can be found inside OpenOffice 3.0 extensions. These are zip files which end with the
.oxt filename extension. To extract the Hyphen .dic file, rename .oxt to .zip and extract the archive. Then
copy the “hyph_xx yvv.dic” file to the Hunspell language directory as described above.

OpenOffice dictionary extensions can be found here:
http.//extensions.services.openoffice.org/en/dictionaries

The first two (in some cases three) letters are lowercase and represent the language name. These are mand-
atory, they can be followed by an optional country code. There must be an underscore separator *_" between

the language code and the country code. The country code is in uppercase.

More info on language codes is found here:
http://en.wikipedia.org/wiki/ISO_639

More info on country codes is found here:
http://en.wikipedia.org/wiki/ISO_3166

After installing MindHyph your InDesign Plug-ins and Dictionaries folder should look something like:

Adobe InDesign C55
£ Configuration
[0 Documentation
[ Fonts
£ Legal
[ Logs
[&] Plug-Ins
» [ Data Services
v [ Dictionaries
|ﬂ Dictionary Editor Dialog.InDesignPlugin
» [ uo
» [ MindGrammar
v [ Mindspell
» @ Aspell
v Hunspell
v [enus
[ en_us.aff
& en_US.dic
s hyph_en_US.dic
[ thes_en_us.dat
D thes_en_US.idx
» [ ruRU
> [0 Mac 0s X
|| MindHyph.InDesignPlugin
|ﬂ MindSpell.InDesignPlugin
|ﬂ MindThes.InDesignPlugin
Filters
Graphics
InCopyWorkflow
Interactive
Layout
Mindsteam
|ﬂ LanguagelLamp./nDesignPlugin
4] LanguageLampPro.InDesignPlugin
|| | anguageLampUl.InDesignPlugin
ﬂ MindEngine.InDesignPlugin
|ﬂ MindGrammarPro.InDesignPlugin
|ﬂ MindGrammarUl.InDesignPlugin
|ﬂ MindSpellPro.InDesignPlugin
|ﬂ MindSpellUl.InDesignPlugin
| MindThesULInDesignPlugin

4dryvvryvwvyy

FEEEERE

dvyvyvrvyy
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Activating MindHyph in InDesign and InCopy for Existing Languages

After initial installation, MindHyph needs to be activated in the Dictionary panel of the InDesign/InCopy pref-
erences. You may only use one hyphenation service per language at a time. Choose the Language you wish to
apply work with. Then in the Hyphenation menu choose the “MindHyph” menu item.

Afterward you will need to set the preferences and then quit and restart InDesign. This allows the linguistic
manager to register the languages and hyphenation services.

“_

General Dictionary

Interface
Type — Language: ( English: USA H-‘
Advanced Type

fUsers/mindsteam/Library/Application Support/Adobe Linguistics /Dictionaries (Ac
Compasition

Units & Increments
Grids
Cuides & Pasteboard

Dictionary =S R[] dh =
Spelling

Autocorrect Hyphenation: [ MindHyph I-G-‘

Notes Spelling: | Proximity |

Track Changes = -

Story Editar Display Double Quotes: " 1-]

Display Performance Slng[e Quotes: 1 ﬂ

Appearance of Black
File Handling
Clipboard Handling
MindGrammar Compose Using: ['User Dictionary and Document l-ﬂ
Mindspell

— Hyphenation Exceptions

— User Dictionary

"1 Merge User Dictionary into Document
E Recompose All Stories When Modified

( Cancel )(—6!(—3

Dictionary Preferences

Using MindHyph

After setting up the languages for MindHyph you are ready to begin using the hyphenation service. MindHyph
works just like the built-in hyphenation for InDesign. You can open the Dictionary dialog and hyphenate words
with the Hyphenate button, and use the Paragraph panel to define hyphenation parameters.
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Uninstall

Uninstallation on Mac OS X systems

To uninstall MindHyph, open the MindHyph folder in your Applications folder. You will find a sub-folder for
each InDesign/InCopy version MindHyph has been installed for. Open the sub-folder of the installation you
would like to remove, double-click on Remove, and then follow the uninstall program instructions.
Uninstallation on Windows systems

To uninstall MindHyph, open the MindHyph folder in \Program Files\Mindsteam Software. You will find a
sub-folder for each InDesign/InCopy version MindHyph has been installed for. Open the sub-folder of the insta-
llation you would like to remove, double-click on Remove, and then follow the uninstall program instructions.
Support

An up-to-date FAQ for MindHyph for Adobe InDesign/InCopy is available at:

http://www.mindsteam.com/products/MindHyph/faq.html

Contact us by mail at support@mindsteam.com

Adobe, InDesign and InCopy are either registered trademarks or trademarks of Adobe Systems Incorporated in
the USA and/or other countries. Microsoft Windows is a registered trademark or trademark of Microsoft Cor-
poration in the USA and/or other countries. Mac OS X is either a registered trademark or trademark of Apple
Computer, Inc.

Copyright 2010 Mindsteam Software
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MindSpell 1.3 for Adobe InDesign/InCopy

For the latest information on MindSpell view the read me file with this installer.

Installing dictionaries

After you have installed MindSpell, you will likely want to install dictionaries to use with InDesign/InCopy. You
will need to install the dictionary folders before launching InDesign. The dictionary folders described below will
define which new languages will be created in InDesign, and which services are available to these new languag-
es as well as existing languages.

Hunspell

For both Macintosh and Windows the Hunspell service is supported.

You will find Hunspell dictionaries at the following urls:

http://wiki.services.openoffice.org/wiki/Dictionaries
http://ftp.services.openoffice.org/pub/OpenOffice.org/contrib/dictionaries/

Install your Hunspell dictionary in:
InDesign/Plug-ins/Dictionaries/MindSpell/Hunspell/<xx YY>

The hunspell dictionary folder <xx_yv> must contain the files xx_vvy.dic and xx_vv.aff. These files com-
prise the heart of the dictionary service. For example, the en_us folder would contain the en Us.dic and
en US.aff files.

Note: hunspell dictionaries can be found as OpenOffice 3.0 extensions, zip files which end with the .oxt file-
name extension. To extract the hunspell dictionary files, rename .oxt to .zip and extract the archive. Then copy
the files to the hunspell directory as described above.

OpenOffice dictionary extensions can be found here:

http.//extensions.services.openoffice.org/en/dictionaries
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Aspell
For both Macintosh and Windows the Aspell service is also supported.
Aspell dictionaries can be found at these urls:

ftp://ftp.gnu.org/gnu/aspell/dict/Oindex.html|
http://aspell.net

Install your Aspell dictionary in:
InDesign/Plug-ins/Dictionaries/MindSpell/Aspell/<xx YY>

Mac OS X
For Macintosh, the Mac OS X spelling services are also supported.

For Mac OS X, the dictionaries are determined by the folder structure and already created by the installer.
Depending upon which version of Mac OS X you are using will determine which languages are pre-installed by
the installer. Additional Mac OS X languages can be added via the same manner, however it will be up to you to
install the appropriate Mac OS X spelling service for that language.

The installed Mac OS X dictionaries are at:
InDesign/Plug-ins/Dictionaries/MindSpell/Mac OS X/<xx YY>

Note that in Snow Leopard, Mac OS X 10.6, the OS supports Hunspell dictionaries, so it is possible to use the
Hunspell dictionaries via the Mac OS X spelling service.

In all of the above examples the folder name <xx_YY> should be replaced with the correct ISO language and
country codes for your language. For example, en_US is “English (United States)”. Normally the packages found
on the Hunspell and Aspell sites have their folders already named with the appropriate codes.

The first two letters are lower case and represent the language name. These are mandatory. They can be fol-
lowed by an optional country code. There must be a separator ‘' between the language code and the country
code. The country code is in upper case.

More info on language codes is found here:
http://en.wikipedia.org/wiki/ISO_639

More info on country codes is found here:
http://en.wikipedia.org/wiki/ISO_3166
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After installing your dictionary folders your InDesign plug-ins Dictionaries folder should look something like

this.
& Dictionary...signPlugin [ Aspell - = |9 en_us.aff
2 uo = [ Hunspell - en_US.dic
[ Mindspell [ Macosx P - m = README_en_US.txt

|=] MindSpell....signPlugin

4| e

First launch

Initializing MindSpell is a two launch process. The first time you launch InDesign after installing MindSpell you
will need to select which spelling services you wish MindSpell to support. Also you will need to choose if you
wish to use InDesign language names (when available) or alternatively ICU language names. For example, “Eng-
lish: US” when the preference is on or “English: United States” when it is off. You may make these settings in
the MindSpell preferences panel, shown below.

“

Ceneral MindSpeII

Interface

Type —Spelling Service Provider

Advanced Type g GNU Hunspell

Composition g GNU Aspell

Units & Increments

— ™ Mac 05 X

Cuides & Pasteboard

Dictionary ~Language Names

Spelling .

P ™ Use InDesign Language Names
Notes.

Track Changes —Spell Check Options

Sl L) ] Ignore UPPERCASE Words
Display Performance X

Appearance of Black "1 1gnore Words with Numbers
File Handling

Clipboard Handling
MindGrammiar

MindSpell
—

A—
w 4
v w
— o —
5§ O F T W A R E

( Cancel )E—OI(—)
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Once you have selected the spelling services you would like to use and set the Language Names flag relaunch
InDesign. MindSpell will parse the folder structure of the dictionaries to create the necessary InDesign lan-
guages (if they do not yet exist).

Spell Check Options

There are two additional settings when spell checking a document when using one of the MindSpell spelling
services. You can ignore all words in uppercase, and you can ignore all words containing one or more digits.

Spell Check Options

[ lignore UPPERCASE Words
] Ignore Words with Numbers

Activating MindSpell in InDesign and InCopy for Existing Languages

After installation, MindSpell has to be activated in the dictionary section of the InDesign/InCopy preference
panel. Simply select the language you wish to use. Then in the Spelling Services menu select the service. You
may have more than one service installed. For instance on the Mac, you could have all three services “Aspell”,
“Mac OS X”, and “Hunspell” installed. You may only use one spelling service per language at a time. Below is a
screen shot of the Dictionary preferences panel.

— Language: English: USA F':'i

HO:Users: mindsteam:Library:Preferences:Adobe InDesign:Version &.0:en_US:Dictior

== @l ¢ =

Hyphenation: a Proximity H"J

Spelling:
Double Quotes: Hunspell
[ Aspell |

Single Quotes: | Proximity E
S

User Dictionaries

MindSpell for InDesign/InCopy uses XML-based user dictionaries. If you would like to continue using the user
dictionaries of the standard InDesign/InCopy correction tool “Proximity” with MindSpell, you will be able to
export them using Proximity and to import them using MindSpell. Use InDesign’s dictionary dialog to achieve
this.
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Scripting

In MindSpell 1.3 we have introduced two new scripting events to the scripting model. spell check and
suggest have been added to the word object in scripting.

Spell Check Event

A word object can call the spell check event and it will return a value indicating if the word is correct, mis-
spelled, or uncapitalized.

5 main();
& function main()
7 H{
B app.scriptPreferences.userinteractionLevel = UserintermctionLevels.intermctWithAll;
g if (app.documents.length != 0}
10 = {
11 Elj if (app.selection.length 1= 0)
12 =] {
13 var mySelection = app.selection[0];
14 switch (mySelection.constructor.name)
15 = {
16 Elj case "Word":
17 = {
18 var spellResult = mySelection.spellCheck();
19 alert (spellResult);
20
21 var suggestions = mySelection.suggest{);
22 alert {suggestions});
23
24 break;
25 = ¥
26 default:
27 =
28 alert{"Please select a word and try again."};
29 - 3
30 - 3
31 - b
32 else
33 =
349 alert{"FPlease select a word and try again."};
3s - b3
36 R
37 else
3B = {
39 alert{"Please select a word and try again.");
40 e
4 )

Spell Check and Suggest JavaScript
Suggest Event
A word object can also call the suggest event and it will return a list of spelling suggestions to the word.

Note: This even works if the word is correctly spelled.
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Uninstallation
Uninstallation on Windows systems

To uninstall MindSpell, open Program “Files\Mindsteam\MindSpell for Adobe InDesign/InCopy inthe
Windows start menu, select Remove, and then follow the uninstall program instructions.

Uninstallation on Mac OS X systems
To uninstall MindSpell, open the Mindspel1l folder in Applications. You will find a sub-folder for each InDe-

sign/InCopy version MindSpell has been installed for. Open the sub-folder of the installation you would like to
remove, click on “Remove”, and then follow the uninstall program instructions.

Support

An up-to-date FAQ for MindSpell for Adobe InDesign/InCopy is available at:
http://www.mindsteam.com/products/mindspell/faq.html|

An up-to-date list of available languages can be found at:
http://www.mindsteam.com/products/mindspell/languages.html|

Contact us by e-mail at support@mindsteam.com

Adobe, InDesign and InCopy are either registered trademarks or trademarks of Adobe Systems Incorporated in
the USA and/or other countries. Microsoft Windows is a registered trademark or trademark of Microsoft Cor-
poration in the USA and/or other countries. Mac OS X is either a registered trademark or trademark of Apple
Computer, Inc. Aspell and Hunspell are licensed under the GNU LGPL license.

Copyright 2008-2010 Mindsteam Software
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What is World Tools? /

What is World Tools?

Prior to InDesign CS4, the only way to work with Documents which con-
tain right-to-left components (which are necessary for Arabic or Hebrew
composition) was by using the ME (Middle Eastern) version of InDesign.
With CS4, this has all changed. Adobe has included an additional composer
called the World-Ready Composer which is capable of composing right-to-
left languages. The World-Ready Composer also has the added capability of
composing Indic languages.

Under the hood, all of the functionality of the ME version of InDesign is
there in every version of InDesign CS4. Adobe has decided to keep this
functionality hidden. The ME capabilities are only apparent when one tries
to open ME documents (they open flawlessly in CS4). The composer which
is enabled by default is the regular composer used in previous versions of

InDesign which does not support right-to-left text.

World Tools was created to exposed this dormant capability within CS4. It
enables the World-Ready Composer as well as provides a user interface to
be able to use it. It was created to enable all users of InDesign to edit docu-

ments with Arabic, Hebrew, and Indic text.

What World Tools is NOT!
World Tools is not a full replacement for the ME version of InDesign. There
are many reasons why one would want or need to purchase the ME version

of InDesign.

First of all, World Tools is based on technology which Adobe considers
unsupported. Adobe did not expose the World-Ready Composer, because
they are not ready/willing to support it yet. We have tested the technology






World Tools Pro

to the best of our ability, and it works well, but they are bugs in the compos-
er which the ME version addresses. If any of these bugs are show-stoppers,
then the ME version is the only solution. We will address bugs in the user in-
terface to the best of our ability, but any bugs in the underlying technology,
is beyond out abilities to address. There is no guarantee by Adobe that they
will even attempt to fix ME related bugs in incremental updates of CS4. This
being said, we would like to receive any information on ME related bugs, so

we can try to analyze them and alert Adobe of their existence.

Also, World Tools does not attempt to achieve the level of integration that
the ME interface has. As a result, the interface of the ME version is much

smoother and more familiar.

If you need control of right-to-left text in Photoshop, Illustrator, or Dream-
weaver, it might pay to buy the ME version of the Creative Suite

Some advantages of World Tools are: 1) price — you don’t need to buy awhole
new program just for right-to-left composition. 2) Timely updates — histori-
cally, the ME updates took much longer to be released than the regular ones.
3) Use of right-to-left functions in the CJK versions of InDesign. The ME
versions and CJK versions of InDesign are mutually exclusive. 4) Localized
interfaces — World Tools can be used with any version of InDesign — no mat-
ter what the language of the user interface might be. The ME version only
has English (IE), French, Hebrew, and Arabic interfaces.

World Tools also includes a number of functions which further aid in multi-

lingual layout:

1. Apply Hebrew Character Style: This will apply a user-defined character
style for Hebrew text within a non-Hebrew paragraph.





What is World Tools?

2. Apply Latin Character Style: This will apply a user-defined character
style for text which uses the “Latin” writing script within a non-Latin para-
graph. (“Latin” includes: English, Spanish, French, etc.)

3. Straighten Quotes: This is for making quotes “dumb”. Useful for lan-

guages which don’t use curly quotes, such as Hebrew.

4. Switch Story Direction: This provides a menu item for reversing story
direction. The menu item makes it possible to assign a keyboard shortcut to

reverse the direction from right to left and left to right.

S. Create Spread Numbering: This creates “spread numbering” in which
both pages on a spread will be assigned the same number. The numbers will

only increase every other page.
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Installation
World Tools Pro was developed using a product called “APID ToolAssistant”

created by Rorohiko. This necessary central controller does a lot of the low-
level processing. If you are interested in the technology behind the development,
you can read the addendum on page 37.

All the necessary components of World Tools Pro are installed in a single step
by our installers. The installer includes APID ToolAssistant as well.

To run the installer, simply double click on the installer package on Macin-
tosh or the installer wizard on Windows, and it will walk you through the

few steps required.

Macintosh Install

MNO o Install Publisher Suite
N k l. Custom Install on “Macintosh HD"
INsylools.com
Package Name Action Size

© Introduction T InDesign CS3 Install 5.3 MB

E InDesign C54 Install 5.8 MB
R Read Mo ™ InDesign CS5 Install 5.5 MB
O License ™ Documentation Install 11.8 MB

© Destination Select
© Installation Type
® Installation

® Summary

Space Required: 28.3 MB Remaining: 56.23 GB

( Go Back ) ( Continue )
P

On Macintosh you will be offered the option to install on CS3, CS4, or CS5

as shown above. The option to install any version not currently installed will
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be greyed out. We advise that you keep the option to install the documenta-
tion checked.

nmm» Please note: If your installation of InDesign is not in the default
location, you will not be able to install on Macintosh! Before run-
ning the installer, make sure InDesign is located in: /Applications/
Adobe InDesign CSX.

Windows Install

Welcome to the In-Tools Setup
Wizard

This will allow you to modify, repair, update or remove
Reflective Objects for Adobe InDesign.

Itis recommended that you dose all Adobe applications before
continuing.

[inltoolscom

[ Mext = ][ Cancel ]

The Windows installer has the additional step that allows you to select your
InDesign folder:

Choose location of InDesign €54 folder. Setup will use location to install Reflective
Objects.

For example 'C:\Program Files\Adobe'\Adobe InDesign C54' for InDesign CS4.

To continue, dick "Next'. If you would like to select a different folder, dick ‘Browse',

iles (x86) \Adobe \Adobe InDesign C54 Browse...
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Purchasing Licenses and Activation

In-Tools suites and plugin are activated from within InDesign using the
In-Tools Dashboard. To access the Dashboard, select “InTools > In-Tools
Dashboard..”. That will bring up the following dialog:

In-Tools Dashboard

Welcome, Harbs

lin!toolscom
——— g

Product Status Latest Version

World Tools Activated -0. 1.0.5 Update:
AutoFlow Pro Activated 0. 1.0.8
Column Flow Activated -0. 1.0.7
’? Style Utilitles Activated 0. 1.0.8

1 Proper V] Activated 0. 1.0.6
(et Help

Reflective Objects Activated -0. 1.0.5

Power Headers Activated -0. 2.0.5
Side Heads Activated 0. 1.0.7
Story Control Activated
—

Drop Words creates “drop woerds” commaonly used in classic Hebrew typesetting.

The Dashboard shows all the information you need to know about your pl-
ugins (or suites). To activate, simply click on the “Activate” button next to
the product you would like to activate. If it is installed as part of a suite, all
the components of the suite will be activated as a whole. Wait a few mo-

ments while the activation process completes.

When it does, you will need to restart InNDesign. | “comecin o 7o wesste. resse wote.

Cancel






Purchasing Licenses and Activation

To activate, you must have a valid In-Tools account, and you will need to log
in from the Dashboard:

Emall: | sales®@In-tools.com Password: ok ak ke

Login Automatically Remember Login

We recommend keeping both the “Login Automatically” and the “Remem-

ber Login” check-boxes checked. This will ensure you are always logged in
when the dialog is opened (assuming you have an internet connection). If
you try to log in with an email account which is not registered, you will be

given the option to create a new account.

You also must have purchased a license of the plugin to activate it. If you

have not yet purchased a license, you can do so using the “Buy” button:

Euy

For further questions and issues regarding licensing and activation, please

refer to the FAQ web page; or for more help, please visit our forum.




http://in-tools.com/learning/faq/

http://in-tools.com/learning/forum/
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Introduction

Plug-in Versions
Wold Tools CSS comes in two version: a basic version, as well as World Tools

Pro. The difference between the two versions are as follows:

World Tools (Basic) contains features which are necessary for right-to-left
layout, including all the necessary menu commands, style, and find/change
integration, as well as a dedicated World Tools (ME) panel which gives con-

trol of all the necessary features ME related features is a single inteface.

World Tools Pro has all the features of World Tools Basic plus access to fea-
tures used by Chinese Japanese and Korean (CJK) languages. Additionally,
World Tools Pro contains a Composite Font Editor, which can create and
edit “composite fonts” which use different fonts installed in your system de-
pendent on the specific unicode range of your text. There are Kanji, Kana,
Roman, Number, punctuation, straight quote, Hebrew, and Arbaic ranges.
Composite Fonts are exceptionally useful when composing mulitlingual

text in a single paragraph.

ME Options

Directional Settings
There are many different levels of directional controls when dealing with

right-to-left text. Below is an overview of what each type of control does.

1. Document Direction: Controls the binding direction (i.e. which way
the book opens). When a book lays with the front cover up, a left bound
(Roman) document has the spine on the left side, while a right-bound docu-

ment has the spine on the right. Right binding is used for right to left lan-
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guages such as Hebrew and Arabic, as well as Japanese books which are set

in a vertical orientation.

2. Story Direction: Controls which way the columns flow in a multicol-
umn text frame. The story direction is controlled in the ME version by us-
ing the ME text frame tool when creating the story, or changing the story
direction in the story panel. In World Tools, it’s controlled by using the Story

Direction menu items or the World Tools panel.

3. Table Direction: Controls the column direction within tables. In the
ME version, it’s controlled by a button on the tables panel, in World Tools, it’s
controlled by the Table direction menu options or the World Tools panel.

Please note: There is no option for setting the table direction in table styles.

Table direction must be set manually for each table.

4. Paragraph Direction: Do not confuse this with paragraph alignment.
The paragraph direction controls the overall direction of a paragraph. For
example: if you type an English word and then a Hebrew/Arabic word fol-
lowed by a period, if the paragraph direction is left to right the English word
will be on the left, the Hebrew/Arabic word will be to the right of that, while
the period will be all the way on the right. If the paragraph direction is right
to left, the direction will be reversed with the English word on the right, the
Hebrew/Arabic word to the left of that, with the period all the way on the
left. If there is not a mix of directions within the paragraph (i.e. all English
text), the only effect of paragraph direction will be on the punctuation at the
end and the position of drop caps/numbering/bullets.

nnm  There is a difference in behavior between the ME version and
World Tools. In the ME version, when you change the paragraph

direction, the paragraph alignment is automatically reversed
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as well. We have found this behavior annoying (we think the
alignment should be kept as it’s defined!) so we changed it in
World Tools The alignment can be manually set to whatever you

want.

S. Character Direction: This controls the direction of characters. “Word”
will come out “droW” when set to right to left. “Default” determines the di-
rection based on the writing script. When set to “Default” neutral characters

(like punctuation) are determined by the surrounding characters.

6. Keyboard Direction: In CS2 version 4.0.2, Winsoft introduced “Key-
board Direction”. The idea sound nice at first, but one which we believe is ill
conceived. Basically Keyboard direction does the same thing as Character
Direction (although character direction trumps keyboard direction when
there’s a conflict). The difference is that keyboard direction can be set au-
tomatically while typing. There’s an option to have the keyboard direction
on neutral characters inferred by the keyboard layout used when typing. If
a right to left keyboard layout is used, the keyboard direction is set to right
to left and vice versa. The problem is (besides the double functionality) that
people don’t always use the correct keyboard layout while typing. When
switching between languages, it’s very common to not switch keyboard lay-
out until starting to type. The neutral characters then have their direction
set by the user. The real problem is directional neutral characters (like pa-
renthesis, brackets, etc.) The appearance of the characters are affected by
their direction. For example: (parenthetical statement) will be encoded
<0028>parenthetical statement<0029> if the parenthesis are right to left
and <0029>parenthetical statement<0028> if the parenthesis are left to
right. This really gets messy once you start doing search and replaces, etc.
Things get really messed up and the user has no idea why...
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To make matters worse, the keyboard direction settings do not show up as
style overrides so there’s no indication that they are applied unless you go

and check the keyboard direction menu listing...

We have not included the ability to set keyboard direction because we are
opposed to its existence. We strongly advise anyone receiving files from an
outside source to use the “Remove Keyboard Direction Overrides” com-
mand to ensure there are no keyboard direction settings anywhere in the

document.

Additional CJK Directional Controls

1. Column Orientation: In Japanese composition, text can be either verti-
cal or horizontal. When text is composed horizontally (as is the case in Ro-
man text), text columns are vertical—and column guides are as well. When
composing multi-column vertical text, the columns are horizontal. World
Tools Plus allows for setting horizontal columns in the World Tools (CJK)
panel.

2. Text Orientation: Japanese text can be set horizontally or vertically. For
vertical text, the story orientation should be set to vertical. This is set in the
World Tools (CJK) panel as well.

3. Table Orientation: Japanese tables which have vertical text are similar-
ly set as vertical rather than horizontal tables. Again, this is a toggle in the
World Tools (CJK) panel.

World-Ready Composer

As stated above, InDesign’s World-Ready composer creates the ability to
properly compose right-to-left text and all related features. It is our under-
standing that the World-Ready composer is based on Winsoft’s ME code






World Tools Pro

base, so for the most part, the functionality should be similar to the ME
version. Any features relating to text composition which are available in the
ME version, but have not been available in the Roman version, will only
be properly composed if the World-Ready Composer is enabled. Any bugs
which might be related to the World-Ready Composer will also only be an
issue if the World-Ready composer is enabled for specific text. Some exam-
ples of features which are only available with the World-Ready Composer

are: localized digits, diacritic positioning, Hebrew / Arabic numbering, etc.

Japanese Composer

To use many of the myriad features offered by World Tools Pro, you must
use the Japanese composer. This includes vertical text, kinsoku-shori, moji-
kumi, tatechuyoku, ruby, kenten, character rotation,etc. Few, if any, of these
features will work unless the composer being used is the Japanese one. To
use the Japanese composer, select it in any of the drop-downs which allow

for setting the composer.

Please note: The World-Ready Composer and the Japanese Composer of the
CJK (Chinese, Japanese, and Korean) versions of InDesign are mutually ex-
clusive. The World-Ready composer does not support CJK line breaks or
the other CJK features, and the Japanese Composer does not support right-
to-left text or other ME features. This means that you must choose whether
you need proper ME / Indic composition, or CJK composition. Each para-
graph can be set with a different composer. For paragraphs with mixed CJK
and ME / Indic text, you must decide which composition rules are more
important. To access features of the Japanese Composer you must use either
World Tools Plus, or the CJK versions of InDesign.





Working with World-Ready Documents /

Working with World-Ready Documents

There will be three instances where you would be working with a World-
Ready document. 1) You are working on an existing ME document (created
in the ME version). 2) You are creating a new document which will have
right-to-left text. 3) You are editing an existing Roman or CJK Document,
and would like to add right-to-left text to the existing document.

Existing ME Documents

Existing ME documents will open correctly in any version of InDesign. You
do not even need World Tools for this. The World-Ready Composer will be
enabled by default and you can even make minor edits to the ME text. For
any edits which require control over ME features, though, you would need
either World Tools or the ME version of InDesign.

Existing Documents

To add ME or Indic text to an existing Roman or CJK document, you must
enable the World-Ready Composer. For Roman Documents, you can sim-
ply select “Enable World Ready Composition”. This will change any instance
of the regular Paragraph Composer or Single-line Composer to the corre-
sponding World-Ready Composer. For CJK documents, selecting this op-
tion will not have an effect on text that has the Japanese composer applied.
Instead you must select the World-Ready Composer for the appropriate
paragraphs or Paragraph Styles.

New Documents
By default, new documents in InDesign do not have the World-Ready Com-
poser enabled. To enable the World-Ready Composer, you can simply cre-

ate a new document and select the World-Ready Composer instead of the
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regular composer. There is also “Enable World-Ready Composition” in the
menu options which enables the World-Ready Composer for all text and
paragraph styles in the document. A document which was World-Ready en-
abled by World Tools is identical to a document which was created in the

ME version of InDesign.

Binding Direction

Binding Direction refers to the side of the pages on which a book is bound.
Books are either right bound or left bound. Books which are primarily writ-
ten in left-to-right languages are left bound, while books which are primar-
ily written in right-to-left languages (Hebrew or Arabic) are right bound.
The other type of book which is right bound is vertical Japanese. Japanese
books which are set horizontally are left bound, while ones set vertically are

right bound.

Binding direction can be set using the menu item: InTools >World Tools
Document > Right Bound/Left Bound Document. The binding direction
can also be set using the World Tools panels (see page 25).

ME Character Settings

OpenType Settings

There are a number of OpenType settings not normally available in the Ro-
man version of InDesign. World Tools makes these settings available under
the Character menu. The OpenType features require a font which supports
them. The additional features available are as follows: 1) Historical Forms:
These are special forms of letters which are generally somewhat archaic.
2) Justification Alternates: These are special stretched forms of glyphs which
are generally used to better justify text. These are the forms used by “Naskh
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Justification”. 3) Localized Forms: There are different forms of glyphs in
some languages. This feature applies the localized form. 4) Mark Position-
ing: Presumably this applies mark positioning programmed using the “mark”
OpenType feature. In our tests, we have not seen any effect by changing this
setting. We recommend using the Diacritic Positioning settings instead.
S) Overlap Swash: This enables swashes to overlap the following glyph pre-
venting unsightly spacing. This is commonly used in Arabic. 6) Stretched
Alternate: Enables the stretched forms of glyphs. 7) Stylistic Alternate: Uses
the glyph form programmed with the “salt” OpenType feature.

Kashidas
This option enables the use of kashidas in Arabic fonts. Kashidas are ex-

tended elements of glyphs which are used when justifying Arabic text.

Digit Types

Different languages around the world use different digit formats. The most
commonly used format for digits is what we call Arabic digits (1,2,3, etc.).
The World-Ready Composer supports 18 different digit formats.

Diacritic Positioning

(8] Diacritic Positioning...

Diacritic Position | OpenType I—:]

Horizontal 0 Vertical 0

The Diacritic Positioning dialog is a non-modal dialog which controls the
position of diacritic marks. For automatic OpenType positioning of marks,
select “OpenType” from the upper drop-down list. If you are using an old-
er non-OpenType font, you can select any one of the other options. The

» «

“Loose”, “Medium” and “Tight” settings affect the vertical placement of dia-
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critics in Arabic. In addition to the automatic placement, the diacritic can be
manually moved by editing the Horizontal and Vertical values. These values

are measured in 1/1000 em units.

Character Direction

Character direction controls which characters are considered right-to-left
and which ones are considered left-to-right. Under normal circumstances
Roman characters (as well as most writing scripts in the world) are left-to-
right. Arabicand Hebrew are the primary examples of scripts which are right-
to-left. When the character direction is set to “Default” InDesign tries to de-
termine automatically what the correct character direction is. For the most
part, this is simply a function of which Unicode range the glyph falls within.
Ifit’s in the Hebrew or Arabic range, it will be right-to-left, otherwise, it will
be left-to-right. For neutral characters (i.e. punctuation), InDesign uses an
algorithm to determine if they should be right-to-left or left-to-right. This is
based on the paragraph direction as well as the surrounding characters. Gen-
erally the Character Direction should be left with the default setting, unless

the default behavior puts neutral characters in the wrong place.

Keyboard Direction

In World Tools we did not include the ability to set keyboard direction. We
do not recommend its use, and we recommend removing all keyboard direc-
tion overrides on existing documents by selecting InTools >World Tools

- Character Direction >Remove Keyboard Direction Overrides.

CJK Character Settings
All CJK settings are set using the World Tools (CJK) panel. Please see page

25 for more information.
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Digits
World Tools Pro offers the ability to set any one of 20 numbering formats
which enables the use of the standard numbering systems used by many dif-

ferent languages.

Character Rotation

World Tools Pro offers the ability to rotate individual characters. For this
to function correctly, the Japanese composer must be used. If one of the
other composers are used, the entire paragraph will be rotated by the values

entered.

Tsume
Tsume is used to adjust the space around a character. It is similar to track-

ing controls, but designed specifcally for the needs of CJK typesetting.

Leading and Trailing Aki

These controls adjust the leading and trailing space of characters.

Tatechuyoko

Tatechuyoko is used to create a row of horizontal text within a column of
vertical text. It is commonly used for things like numbers. Tatechuyoko is
set on the character level and each span of text which has tatechuyoko ap-

plied will be a single row of text.

Ruby

Ruby is text decorations which are used to help in pronuciation of certain
characters. World Tools offers a toggle to turn on and off ruby. It also offers
a dialog which gives fine control over the appearance of the ruby. The dialog
is available from the World Tools (CJK) fly-out menu.
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Kenten

Kenten is a text adornment used to emphasize or distinguish words. World
Tools Pro offers a dialog for controlling kenten. It is available from the World
Tools (CJK) fly-out menu.

Warichu
Warichu is in-line text annotations. Whether text is considered warichu, can
be toggled using the warichu checkbox in the World Tools (CJK) panel.

Rotate non-CJK

When composing vertical type, you have the option to set non-CJK text
either upright or sideways. By deafult, non-CJK text will appear sideways. If
you would like it to appear upright, make sure “Rotate non-CJK” is selected.

Paragraph Settings

Paragraph Direction

The paragraph direction sets the overall direction of the paragraph. This
should not be confused with paragraph alignment. For example: if you type
an English word and then a Hebrew/Arabic word followed by a period, if
the paragraph direction is left to right the English word will be on the left,
the Hebrew/Arabic word will be to the right of that, while the period will be
all the way on the right. If the paragraph direction is right to left, the direc-
tion will be reversed with the English word on the right, the RtL word to
the left of that, with the period all the way on the left. If there is not a mix
of directions within the paragraph (i.e. all English text), the only effect of
paragraph direction will be on the punctuation at the end and the position
of drop caps/numbering/bullets.
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Here are some examples of left aligned left-to-right paragraphs:

. A bulleted paragraph.

“n»ay” is “Hebrew”.

“duyel)” is “Arabic”.

Here’s a few left aligned right-to-left paragraphs:
. Abulleted paragraph.

“m “maay “Hebrew”.

“0950 “dsyel “Arabic”.

Paragraph Numbering Formats

Besides the standard Roman Numbering Formats for numbered lists, World

Tools includes six ME numbering formats as well as eleven CJK formats.

Paragraph Justification Options

There are three different paragraph justification options available. These are
all applicable when the text is set to “justified”. The “Standard” setting sim-
ply adds space to justify text. The “Arabic” option will use kashidas to take
up space if kashidas are enabled. The “Naskh” option will use naskh justifi-
cation. If an OpenType font has justification alternates (jalt) programmed
into the font and “Naskh” is selected, these alternates will be used to justify
the text. The algorithm used is unpredictable. The justification alternates

will work in any language.
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CJK Paragraph Settings
All CJK settings are set using the World Tools (CJK) panel. Please see page

25 for more information.

Composer
To correctly compose CJK text, you must select the Japanese composer. The

Japanese composer enables all the CJK related features.

Kinsoku Shori

Kinsoku defines the basic kinsoku shori options for line breaking rules.
World Tools Pro offers five different kinsoku options: hard, soft, Korean,
Simplified Chinese and Traditional Chinese.

Mojikumi
The mojikumi setting allows for fine control over the spacing used when

breaking lines. World Tools Pro offers sixteen mojikumi presets.
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Vs o = [_] Rotate non-CJK
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To access the World Tools panels, select Window > World Tools > World
Tools (ME) or World Tools (CJK). These panels offers access to most of the
right-to-left and CJK features enabled by World Tools Pro.

ME Panel

In the ME panel, the top section offers toggles for Document Direction, Sto-

ry Direction, and Table Direction. The next section offers control of para-

graph attributes such as the composer, Paragraph Direction and Arabic jus-

tification options. The bottom section offers controls for character settings

including direction, digit formats and kashidas. Additionally, there is precise

control over diacritic positioning.
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CJK Panel

The CJK panel is similarly broken into logical sections. There is control over
the various direction and orientation options using toggles in the top sectio
of the panel. In the second section, there is also control over the different
composer options as well as line breaking and spacing options (kinsoku-
shori, mojikumi and gyoudori). The bottom section has the necessary char-

acter related options.

Ruby Settings
There are many ways Kenten and Ruby can be fine tuned in Japanese com-

position. World Tools Pro offers dialogs for controlling these settings:

Ruby Settings
Font: | Kozuka Gothic Pra | Ruby Content: OK
o s | |
Alignment: | s | D Qverhang D Auto Scaling
Parent Overhang: | One Ruby | [ Auto Align [ Auto Tey Auto Scale
Ruby Type: | EERi e | E OpenType Pro I:‘ Auta Tey Include Roman
Fill Color: | |
T A T A
Stroke Color: | | Size: =]  stroke: =
Overprint Fill: | Auto | Fill Tint: @ Stroke Tint: @
Overprint Stroke: | Auto | X Offset: 50 @ Y Offset: 50 @
Parent Spaclng:| | X Scale: 100% @ ¥ Scale: 100% @
Position: | Above Right | Parent Scaling: 66% @ Tey Digits: 1 @

The Ruby dialog is accessible from the World Tools (CJK) flyout menu:

Kenten...

Composite Font Editor...

About
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Kenten Settings
Kenter settings are available using a similar dialog also available in the World
Tools (CJK) flyout menu:

%

= |
ot s |
Alignment: | Center |
Slze: IE Stroke: iﬁ
Character Set: | Character Input |
X Scale: |100% || Y Scale: 100% (=
Kind: | Sesame Dot | - |j © |j

- Stroke Tint: 5 Fill Tint: iﬁ
Distance: 1 iﬁ

Custom Character:

Position: | Abowe Right |
Fill Color: | | Stroke Color: | |
Owerprint Fill: | Auto | Overprint Stroke: | Auto |

Composite Fonts
Composite fonts is a feature which has existed in the CJK versions of InDe-
sign for a long time, and in World Tools Pro, we are bringing their use to all

InDesign users for the first time.

Composite Font: My Custom Composite Font *
Range ot siie wxe | Baseine | V/scle | Wocle | [
Kana Kozuka Mincho Pro R 100% o 100% 100% ks
Roman Minion Pro Regular 100% o 100% 100% v
Hebraw Vilna Regular 110% o 100% 100% 04
Arabic DecoType Naskh Regular 100% o 100% 100% v
Add Range
Kozuka Mincho Pro |[® 100% (5|0 ~(100% [5+(100% 5+ [
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Simply put, composite fonts are pseudo-fonts which are made up of two or
more real fonts. Composite fonts allows you to select which fonts should be
used for specific Unicode ranges to correctly display characters in many dif-

ferent languages while using only a single font.

Creating Composite Fonts

To create a composite font do the following:

1. Open the Composite Font Editor. The Composite Font Editor is avail-
able from one of three locations: Window > World Tools > Composite
Font Editor, the fly-out menu of the World Tools (ME) panel or the fly-out
menu of the World Tools (CJK) panel.

2. Click “New Font”. This will create a new composite font with a single
range (Kanji). Kanji is the base range for every composite font, and it can-
not be changed. All adjustment of the other ranges are relative to the base

range.

3. Name your composite font. You can type the name directly into the
composite font combo-box. The name you give it will be the name which

appears in the font lists.
4. Add any ranges you need.

S. Select the font to use for each range. You can specify scaling and base-

line shift as well.

Using Composite Fonts
Composite fonts are used the same way regular fonts are used. Simply se-
lect your custom composite font from the font drop-down list. Documents

which use composite fonts have the composite font data embedded in the
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file, and should open correctly on any system using InDesign CSS5. The one
limitation is that all fonts used in a composite fonts must be installed for the
composite font to display correctly. The “document fonts” feature of CSS is

not compatible with composite fonts.

Style Settings

Paragraph Style Options

General Style Name: Main Text

Basic Character Formats Location: Text Styles

Advanced Character Formats World-Tools Options

Indents and Spacing Paragraph

Tabs

Paragraph Rules Direction: | Left to Ri... B: Justification: | Standard B:
Keep Dptions

Hyphenation Character Diacritics

lustification

Direction: | Default B: Diacritic Position: | OpenType B:
Span Columns —
Drop Caps and Nested Styles Digits: | Default B: Adjustments: Vertical: +0

GREP Style ) ) T
) Kashidas: | On o Horizontal: =0

Bullets and Numbering

Character Color

OpenType Features OpenType

Underline Options [ Justification Alternate M Mark Positioning _| Overlap Swash

Strikethrough Options
> [ Stylistic Alternate | Historical Forms [_| Roman ltalics
World-Tosls Options &) =] =

|| Stretched Alternate ELocaIized Forms

[ Preview (" Cancel ) E—GH

World Tools ME style settings are set in the standard style dialogs. Shown
above is the paragraph style options. Almost all the World-Ready options
are set using the “World-Tools Options” section. This includes, direction,

justification, character attributes, and OpenType attributes. The one excep-
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tion is the composer options which are added to the composer drop-down
in the “Justification” section as show below:

Cr e Lad Il
Adobe World-Ready Single-line Composer

[T v Adobe World-Ready Paragraph Composer

Adobe Japanese Single-line Composer

Adobe Japanese Paragraph Composer

Adobe Paragraph Composer

Adobe Single-line Composer

Single Word Justification-

I

The character style dialog is similar, but without the paragraph level attri-

butes:
Character Style Options
General Style Name: Header
Basic Character Formats Location:
Advanced Character Formats World-Tools Options

Character Color
Character Diacritics
OpenType Features

Underline Options Direction: B: Diacritic Position: B:
Strikethrough Options

World-Tools Options Digits: B: Adjustments: Vertical: =
Kashidas: B: Horizontal: =

OpenType

[=] Justification Alternate [=] Mark Positioning [=] Overlap Swash
[=] Stylistic Alternate [=] Historical Forms [=] Roman lItalics
[=] Stretched Alternate  [=] Localized Forms

[ Preview (" Cancel ) E oK 3

CJK Style Settings

There is currently no section in the style dialogs for setting CJK options, so
itis not possible to adjust CJK settings directly in the style dialogs. However,
it is possible to define styles with CJK settings. To do so, is a two step pro-
cess: 1. Set whatever CJK specific settings you need using the World Tools
panel. 2. Use the “Redefine Style” command.
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Redefine Style is accessible from a number of locations: a) There’s a key-
board shortcut: Command/Control + Option/Alt + shift + R. b) From the
control panel you can select Redefine Style from the dropdown next to the
style dropdown. c) Right clicking the style listing in the style panel d) The
command is available in the style panel flyout menu. Once a style is defined
with CJK options, these options will appear in the list of style attributes.

Find/Change Options

All ME World Tools options can be selected in both the find and change
dialogs as well:

Find Format Settings

World-Tools Options

Paragraph

Direction: | Right to... B: Justification: | B:
e Character Diacritics
an Calumns — R . m
Direction: | q. Diacritic Position: | B.
Bullets and Numbering L -
Characts Digits: | )-_—i: Adjustments: Vertical: =
OpenTy Kashidas: | B Horizontal: ~
Underl ions
Strikethrough Options CResTybe
Conditians [=] Justification Alternate [=] Mark Positioning [=] Overlap Swash

World -Tools Options.

[=] Stylistic Alternate [=] Historical Forms [=] Roman Italics
Drop Caps and Other

[=) Stretched Alternate  [=] Localized Forms

Other Options

Table Direction

The direction of a table determines whether columns start on the left or
right. The table direction is set by selecting InTools > World Tools > Ta-
ble Direction > (Left To Right / Right To Left). Table direction cannot be
set in table styles. The direction must be set manually on an individual basis.

The table direction can also be set in the World Tools panel (see page 25).
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Story Direction

The story direction controls whether columns of text in multi-column
frames flow from the right-to-left or left-to-right. The story direction is indi-
cated by the position of the in-ports and out-ports of text frames. The story
direction can be switched at any time by selecting InTools > World Tools
- Story Direction > Left to Right/Right to Left Story. The story direction

can also be set in the World Tools panel see page 25 for more information.

Footnote Numbering Options
Besides the standard Roman footnote numbering formats, World Tools in-
cludes four ME numbering formats as well as two CJK formats. This setting

is a document-wide setting, and is applied to the current document.

Chapter Numbering Formats
The Chapter Numbering format is also a document-wide setting. World

Tools includes six ME formats and eleven CJK formats.

Page Numbering Formats

The page numbering format is the format that the numbers take when using
automatic page numbers. Besides for the standard Roman number formats,
World Tools enables the use of four ME formats. The page numbering format

is applied to the section of the current active page.

World-Ready Composer

World Tools adds two new menu items to the Control Panel and Paragraph
Panel drop-down menus. Besides the standard Single-line and Paragraph
Composers, you can select the World-Ready variants of these composers.
Usually, there’s no reason you'd want to use the regular composers over the

World-Ready ones. The World-Ready composer is a super-set of the regular
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composer. However if you encounter a bug which is specific to the World-
Ready Composer, switching to the regular composer would be a work-
around the bug (although that would preclude working with ME text.) Also,
if you are using the CJK versions of InDesign, you might want to select the
Japanese Composer instead. The World-Ready Composer is a parallel com-

poser, and does not support the Japanese aspects of the Japanese Composer.

Additional Options

Apply Hebrew Character Style

A “writing script” is the set of characters used by the computer to compose
text. Each writing script uses a unique set of characters. Each scriptis unique,
but a script can include more than one language. For example, the Hebrew
script is used by Hebrew and Yiddish. The Latin script is used by English,
Spanish, French, and many others. The “Apply Style” functions recognize

characters based on their script, and apply character styles accordingly.

“Apply Hebrew Style” creates a Hebrew Character Style for Hebrew text.
This function should be used when the main paragraph text is in a language
other than Hebrew, and the Hebrew text needs its own formatting. It identi-
fies any text belonging to the Hebrew writing script, and takes into consid-
eration all Hebrew letters, nikud (vowel marks), and taamei hamikra (cantil-
lation marks). Additionally, it makes all single and double quotes “dumb’,
and applies the style to punctuation within Hebrew text. For example the
statement: This is jayn “Tixn” 190! becomes: This is yiyn “Txn” 790! In this
example the Hebrew style is styled with Fontbit David at a reduced size, the
quotes within the Hebrew statement had the Hebrew style applied to it and

were straightened. The exclamation point immediately after the Hebrew text
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retains its regular formatting. The character style should be set before run-

ning this command.

Apply Style To Hebrew Characters:

Source Paragraph Style: = Any 3] Ei)
Character Style to Apply: | [None] =2 ] (__Cancel )
Apply To: ) Document

() Story
() Selection

The above dialog box shows the options for applying the style. In the “Source
Paragraph Style” drop down list you can either select “Any” or a specific
Paragraph Style in your document. Choosing “Any” will apply the character
style to any Hebrew text in all the paragraphs of the specified range. Choos-
ing a specific style will limit the application of the style to text styled by that
specific Paragraph Style. Use the “Character Style to Apply” drop down list
to select the Character Style to apply.

The second section in the dialog allows you to select the text range. The op-
tions are context sensitive. If there is nothing selected in the document, the
only selectable range will be the document. If there is a story or part thereof
selected in the document, the “story” radio button will appear. If there are
at least two characters selected, the “Selection” radio button will appear as

well. Selections can be either text or text frames.

Apply Latin Character Style
This option is similar to “Apply Hebrew Character Style”. It styles text be-
longing to the Latin script within a paragraph whose main language uses a

different writing script.
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Apply Style To Latin Characters:

Use Current Find Settings Instead [ ﬁ
Source Paragraph Style: = Any | :] ([ Cancel )
Character Style to Apply: ' [None] =5

Apply To Numbers 8

Apply To: @ Document
() Story
() Selection

The above dialog box shows the options for applying this style. Select “Use
Current Find Settings Instead” to search by criteria such as color, character
style, etc. The last find settings used in the application find and replace dia-
log will be used to find the text. Please note: If the “Use Current Find Settings”
is checked, the selection of the paragraph style is ignored. Whether or not this
box is checked the “Character Style To Apply” must be selected. If “Apply
To Numbers” is selected, numbers within the Latin text will be styled with

the selected character style.

The second section in the dialog allows you to select the text range. The op-
tions are context sensitive. If there is nothing selected in the document, the
only selectable range will be the document. If there is a story or part thereof
selected in the document, the “story” radio button will appear. If there are
at least two characters selected, the “Selection” radio button will appear as

well. Selections can be either text or text frames.

Straighten Quotes
Hebrew and some other languages do not use curly quotes. Very often, curly
quotes can creep into Hebrew text unintentionally. Straighten Quotes was

created to deal with this issue.
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Straighten Quotes based on Style

Character Style to Change: = Any -5 ] ﬁ

Fa

Paragraph Style to Change: = Any B Cancel )

Apply To: @ Document
() Story
(") Selection

The options in the above dialog box are self-explanatory. Select a character
style, a paragraph style, both, or neither. You can also select the text range as
in to the “Apply Character Style” dialogs.

Switch Story Direction

Story direction in InDesign ME version is determined by text tool used to
draw the text frame containing the story. If the ME type tool is used, the
story direction will be right-to-left. If the regular type tool is used, the story
direction will be left-to-right. The importance of story direction is primarily
in the direction of text flow in multi-column text frames. The story direction

is set for the story as a whole, and not on a frame by frame basis.

Without this plug-in, InDesign ME allows story direction to be changed af-
terwards by selecting a different story direction in the Story Palette / Panel.
It is a very inconvenient way to switch story direction, since the only other
function of the Story Palette / Panel is the rarely accessed Optical Margin
Setting. The “Switch Story Direction” option provides a convenient way to
change the story direction. Since the command is a menu item, it allows you

to create a keyboard shortcut make changing story direction even easier.
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Number by Spread
This utility offers the option to increase page numbering once per spread
instead of once per page. This is useful when both pages in a spread need to

show the same page number.

Spread Numbering

Starting Page: | 1 ) ook )
Ending Page: 7 I:] (_ Cancel )

By default, the starting page will be the first page in the document, and the
ending page will be the last. These numbers can be set to any page in the

document, thereby giving spread numbering to only part of the document.

Undoing Spread Numbering
Spread numbering can be undone as well. The numbers in the drop-down

list will be the current page numbers — 1,1,2,2, and so on.

Addendum

What is “APID ToolAssistant”?

Classically, there are only two ways to automate InDesign. One way is by
scripting. Scripts are a series of commands written in one of the three sup-
ported scripting languages — AppleScript for the Macintosh, Visual Basic
for Windows, or ExtendScript for both platforms. ExtendScript is Adobe’s
version of Javascript. For scripts to run, they must be placed in the applica-
tion script folder and explicitly run. For automation to be truly automatic,
it requires “event processing”. This means that certain events trigger specific

processes to take place. There is limited event-triggered scripting available
in CS3.
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To achieve true integration, plug-ins must be programmed using C++. De-
veloping c++ plug-ins is a very involved, and lengthy process. APID ToolAs-
sistant is a plug-in which allows very fine grained event processing using Ex-
tendScript. It allows for creation of advanced plug-ins in a fraction of the
time required when programming using c++. It also aids in the creation of

hybrid plug-ins which mix ExtendScript and c++ for maximum efficiency.

Without the APID ToolAssistant, it would not have been possible to cre-
ate the collection of plug-ins we offer in the same amount of development
time. This increased programming efficiency means more functionality for

the end user and lower prices.

Additionally, APID ToolAssistant offers the ability to attach scripts to spe-
cific objects. These attached scripts can be run automatically when triggered
by specific events. Anyone who has a licensed version of the APID ToolAs-
sistant plug-in installed can create and use these attached scripts. There
are also additional scripting properties and methods which are usable by

scripters.

For more information see Rorohiko’s web site at www.rorohiko.com.
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License Agreement
Please read the following document carefully!

This is a legal agreement (the Agreement) between you and Print Israel LLC (In-
Tools), the developer of the In-Tools software. This Agreement pertains to your use of
the In-Tools software and documentation which are provided to you by In-Tools (col-
lectively, the Software). By copying, installing, or otherwise using the Software, you
accept all the terms and provisions of the Agreement.

Terms of Use
The provisions of the In-Tools Privacy Policy are incorporated herein and made a part

hereof.

License

This Agreement grants you a personal, non-exclusive, non-transferable, non-sublicens-
able right to use one copy of the Software for use on a single computer and/or worksta-
tion for each license that you purchase. You may try the Software before purchasing a
license, for the specified amount of time in the materials accompanying the Software.
YOU UNDERSTAND AND AGREE THAT BY USING THE TRIAL SOFTWARE,
AFTER THE AMOUNT OF TIME YOU MAY NOT BE ABLE TO CONTINUE
TO USE THE SOFTWARE UNLESS YOU PURCHASE A LICENSE.

In-Tools reserves all rights in the Software not expressly granted herein, including

without limitation ownership and proprietary rights.

License Restrictions
You may not reverse engineer, decompile or disassemble the Software. The restrictions
contained herein apply equally to any updates that may be provided to you by In-Tools.

Intellectual Property Rights and Third Party Materials

All service marks, logos, trade names, trade dress, and trademarks of In-Tools (col-
lectively Marks) are the exclusive property of In-Tools and nothing in this Agreement
shall grant you the license to use such Marks. All intellectual property rights in the
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Software are owned exclusively by In-Tools and are protected by United States of
America copyright laws and international copyright treaty provisions. Any violation of
the terms set forth herein is expressly prohibited by law and may result in severe civil

and criminal penalties.

Disclaimer of Warranties

ALL SOFTWARE PROVIDED BY IN-TOOLS ARE PROVIDED AS IS. IN-TOOLS
AND ITS AGENTS, PARTNERS, OR EMPLOYEES MAKE NO REPRESENTA-
TION OR WARRANTY TO YOU OR ANY OTHER PERSON OR ENTITY,
WHETHER EXPRESS, IMPLIED, OR STATUTORY, AS TO THE DESCRIP-
TION, QUALITY, TITLE, NON-INFRINGEMENT, MERCHANTABILITY,
COMPLETENESS, OR FITNESS FOR A PARTICULAR USE OR PURPOSE AS
TO THE SOFTWARE PROVIDED TO YOU, OR AS TO ANY OTHER MATTER,
ALL SUCH WARRANTIES HEREBY BEING EXPRESSLY EXCLUDED AND
DISCLAIMED.

NEITHER IN-TOOLS NOR ANY OF ITS AGENTS, PARTNERS, OR EMPLOY-
EES WARRANTS THAT THE SOFTWARE OR SERVICES ARE ERROR FREE
OR WILL OPERATE WITHOUT CAUSING LOSS OR INTERRUPTION YOUR
COMPUTER USAGE OR DATA. YOU ASSUME TOTAL RESPONSIBILITY
AND RISK FOR YOUR USE OF THE SOFTWARE.

Limitation of Liability

IN NO EVENT SHALL IN-TOOLS, ITS AFFILIATES, SUBSIDIARIES, PAR-
ENT COMPANIES, AGENTS, NETWORK SERVICE PROVIDERS, PARTNERS,
OR EMPLOYEES BE LIABLE TO YOU OR ANY THIRD PARTY IN ANY RE-
SPECT FOR ANY COSTS OR DAMAGES ARISING EITHER DIRECTLY OR
INDIRECTLY FROM THE USE OF IN-TOOLS SOFTWARE INCLUDING
WITHOUT LIMITATION ANY ACTUAL, INCIDENTAL, CONSEQUENTIAL,
EXEMPLARY, PUNITIVE, RELIANCE OR SPECIAL DAMAGES, OR FOR ANY
LOSS OF REVENUE, PROFITS, USE, DATA, GOODWILL OR BUSINESS OP-
PORTUNITIES OF ANY KIND ORNATURE WHATSOEVER, ARISING IN ANY
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MANNER FROM ANY CAUSE OF ACTION OR CLAIM RELATING TO THIS
AGREEMENT, TO THE SERVICES PROVIDED BY IN-TOOLS ORTO THE USE
OF THE SOFTWARE. THIS LIMITATION OF LIABILITY APPLIES EQUALLY
TO ANY THIRD PARTIES WITH WHOM IN-TOOLS ENTERS INTO A BIND-
ING AGREEMENT TO MARKET, DISPLAY AND/OR DISTRIBUTE THE
SOFTWARE TO END USERS AND SUCH THIRD PARTIES SHALL NOT BE LI-
ABLE TO YOU ORANY OTHER THIRD PARTY FOR ANY OF THE DAMAGES
SET FORTH ABOVE.

Export Control Laws.

You agree to comply with all laws, rules and regulations applicable to the export of the
Software. Specifically, you shall not export, re-export or transship the Software, or the
direct product thereof, in violation of any United States laws and regulations which
may from time to time be applicable. None of the Software or underlying information
or technology may be downloaded or otherwise exported or re-exported (i) into, or
to a national or resident of, Cuba, Iran, Iraq, Libya, North Korea, Sudan, Syria or any
other country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S.
Treasury Departmentss list of Specially Designated Nationals or the U.S. Commerce
Department>s Table of Denial Order. By downloading or using the Software, you are
agreeing to the foregoing and you are representing and warranting that you are not
located in, under the control of, or a national or resident of any such country or on any

such list.

Jurisdiction and Other Provisions

This Agreement and the relationship between In-Tools and you shall be governed in
accordance with the laws of the State of New York. Any dispute between you and In-
Tools regarding this Agreement will be subject to the exclusive jurisdiction of the state
and federal courts in the State of New York. You agree to submit to exclusive jurisdic-
tion in the State of New York, and you expressly waive all defenses to jurisdiction.

This Agreement is the entire agreement between you and In-Tools relating to your use

of the Software and supersedes any other communications or advertising with respect
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to the Software. If any provision of this Agreement is held invalid, the remainder of
this Agreement will continue in full force and effect. In-Tools failure to insist upon or
enforce strict performance of any provision of this Agreement shall not be construed
as a waiver of any provision or right. Neither the course of conduct between the par-
ties nor trade practice shall act to modify any provision of this Agreement. In-Tools
may assign its rights and duties under this Agreement to any party at any time without

notice to you.

Modifications of Agreement

In-Tools may modify this Agreement at any time without providing notice to you.
Such modification will be made by posting a revised agreement on its web site and
such modification shall be deemed effective immediately upon posting of the modified
Agreement. Your continued access or use of the Software or Services shall be deemed
your acceptance of the modified Agreement. You agree to check our web site periodi-
cally to review such modifications.

Termination or Modifications of Software

You may terminate this Agreement at any time. The In-Tools may immediately termi-
nate the Agreement if you breach any representation, warranty, agreement or obliga-
tion contained or referred to in the Agreement. Upon termination, you must dispose of
the Software and all copies or versions of the Software by destroying the Software. In-
Tools reserves the right to modify the Software at any time without providing notice to
you. In-Tools right to modify the Software applies to all or any aspect of the Software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND IT AND THAT, BY USING THE SOFTWARE, WEB SITE, YOU
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
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